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Aircraft System Hardware 
Aircraft System displays GPS fault screen with 0 Satellites 
Shorted GPS Antenna cable 

• Disconnect power from DynaFlight 
• Disconnect cable at box and antenna  
• Measure resistance from centre pin to outside shield – if 100,000 ohms or less then antenna 

cable is shorted. 
Open GPS Antenna cable 

• Disconnect cable at antenna  
• Measure voltage – should be 4.5 –5.5 volts while DynaFlight system is running 

Racal interference when GPS Antenna is too close to Processor box 
• Inside the DynaFlight Processor box, remove the jumper connector from the top front of the 

Racal Card (second card from the right when facing the front of the box). This jumper should 
not be there. 

• Reboot the computer system and wait 10 minutes for the system to aquire the satellites and run 
properly. 

GPS Antenna Faulty 
• The above conditions test OK 
• Contact DynaNav Systems Inc. for further instructions 

Aircraft System displays GPS fault screen with 1 or more Satellites. 
Racal interference when GPS Antenna is too close to Processor box 

• Inside the DynaFlight Processor box, remove the jumper connector from the top front of the 
Racal Card (second card from the right when facing the front of the box). This jumper should 
not be there. 

• Reboot the computer system and wait 10 minutes for the system to aquire the satellites and run 
properly. 

GPS Antenna mounted too close to Rotor Mast 
• Depending on the type of helicopter, the GPS antenna should be mounted at least 6 feet from 

the Helicopter Rotor mast 
• For best Satellite visibility, the GPS Antenna should have complete visibility from horizon to 

horizon on top of the helicopter if possible. 
Display Faulty or Dead 
Sections of display black or white 

• Contact DynaNav Systems Inc. for display replacement 
Display totally dead 

Exchange display cable and see if it is the same. 
Exchange display and see if it is the same. 

• If both the Display Cable and the Display do not seem to be the problem, then it will be the 
processor box that is the problem 

• Contact DynaNav Systems Inc. for processor board replacement. 
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Horizontal or vertical lines through display 
Display Cable has broken wires 

• Remove cable and check continuity as per DynaViz Display Wiring Diagram (below) 
• If it is broken, contact DynaNav Systems Inc. for instructions. 

No display and internal fan 
Blown Fuse 

12 – 24 volts NOT on pin “B” and ground is on pin “A” on the power plug for the 
DynaFlight processor box. 

• First make sure that the power leads are not reversed on the power input plug. 
• Make sure that the power from the Aircraft system is coming to the 2 pin plug. 
• Cut Black heat shrink off of inline fuse holder on power input cable(6” from power plug). 
• Replace fuse 5 to 8 amp AGC fuse. 
• Heat shrink or tape up inline fuse holder. 

Power Supply not working 
12 – 24 volts available on pin “B” and ground on pin “A” on the power plug for the 
DynaFlight processor box. 

• Contact DynaNav Systems Inc. for processor replacement. 
Differential System is not operational 
WAAS Differential Corrections 

• Using Aircard Tuneup kit, make sure that the WAAS is checked on the Aircard 
OmniStar Differential Card 

• When showing “Statistics” on the Aircraft system, no OmniStar data is reported onto the 
display. 

• Statistics window on Aircraft system shows “No User Code” or User Disabled”. Needs 
Omnistar subscription to be activated – Call Omnistar at 888-883-8476 to subscribe and 
activate. 

CDGPS Differential Corrections 
• On aircraft system, go to statistics and select click on Differential source and select the CDGPS 

region that suits your area. 
Aircraft Navigation is jumpy and not necessarily within 2 meters of target. 
Differential system has no subscription 

• When showing “Statistics” on the Aircraft system, no OmniStar data is reported onto the 
display. 

• Statistics window on Aircraft system shows “No User Code” or User Disabled”. Needs 
Omnistar subscription to be activated – Call Omnistar at 888-883-8476 to subscribe and 
activate. 

GPS Antenna mounted too close to Rotor Mast or wrong position. 
• Depending on the type of helicopter, the GPS antenna should be mounted at least 6 feet from 

the Helicopter Rotor mast 
• For best Satellite visibility, the GPS Antenna should have complete visibility from horizon to 

horizon on top of the helicopter if possible. 
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Bags are not being marked at all 
Deploy Switch hooked up Backwards 

• Check to make sure that the power to pins 1 & 4, on the 4 pin CPC plug (coming from aircraft 
Deploy/Retrieve switches) from Dual Relay box, shows power when the Aircraft Deploy switch 
is activated and no power when not activated. 

Deploy Switch not hooked up 
• When pilot presses the deploy switch, the navigation display does not show the word 

“DEPLOYING” does not change to “DEPLOYED”. If this is the case, see “Switch actions do 
not work properly” – “Deploy or Retrieve functions do not work” below.  

Deploy Timer on Tuneup is set to high 
To resolve above 

• Put Air Card into base computer and run TUNEUP and set “Delay before Deploy switch is 
recognized” to something less than the time the Deploy switch is held on by the pilot to release 
the Bag. E.g. If the bag deploy switch needs to be held on for 1 second then set the time on 
TUNEUP to .75 seconds.  

• If this does not solve the problem, contact DynaNav Systems Inc. 
Bags are not being marked some of the time 
Deploy Switch hooked up Backwards 

• Check to make sure that the power to pins 1 & 4, on the 4 pin CPC plug (coming from aircraft 
Deploy/Retrieve switches) from Dual Relay box, shows power when the Aircraft Deploy switch 
is activated and no power when not activated. 

Deploy Timer on Tuneup Kit is not set low enough 
To resolve above 

• Put Air Card into base computer and run TUNEUP and set “Delay before Deploy switch is 
recognized” to something less than the time the Deploy switch is held on by the pilot to release 
the Bag. E.g. If the bag deploy switch needs to be held on for 1 second then set the time on 
TUNEUP to .75 seconds.  

• If this does not solve the problem, contact DynaNav Systems Inc. 
Bag is showing dropped when incrementing carousel to new hook location. 
Deploy Timer on Tuneup Kit is set to low 

To resolve above 
• Put Air Card into base computer and run TUNEUP and set “Delay before Deploy switch is 

recognized” to something less than the time the Deploy switch is held on by the pilot to release 
the Bag. E.g. If the bag deploy switch needs to be held on for 1 second then set the time on 
TUNEUP to .75 seconds. This time should be higher than the time it takes the pilot to hit the 
switch for re-setting the carousel. 

• Also check the setting for “Maximum Distance to Accept Bag Drop” is set correctly on 
TUNEUP.  

• If this does not solve the problem, contact DynaNav Systems Inc. 
Switch actions do not work properly 
Enter does not work some or all of the time. 

To test Air Computer for above 
• Remove 9 pin CPC plug (coming from processor box) from Dual Relay box. 
• Power up DynaFlight system 
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• Connect voltmeter (20 volt range) common to pin 9 of plug coming from Aircraft wiring. 
• Test for power on pins 1 through 8, should be between 4.5 and 5 volts DC 
• If any of the pins are less than 4 volts, contact DynaNav Systems Inc. for computer 

replacement. 
To test the switch inputs for the above 

• Remove 9 pin CPC plug (coming from aircraft switches) from Dual Relay box. 
• Connect ohmmeter (20 ohm range) common to pin 9 of plug coming from Aircraft wiring 
• Test 0 ohms on pin 7 when enter switch is activated 
• If this does not happen, troubleshoot the aircraft wiring from plug to Enter switch 

Window does not work some or all of the time. 
To test Air Computer for above 

• Remove 9 pin CPC plug (coming from processor box) from Dual Relay box. 
• Power up DynaFlight system 
• Connect voltmeter (20 volt range) common to pin 9 of plug coming from Aircraft wiring 
• Test for power on pins 1 through 8, should be between 4.5 and 5 volts DC 
• If any of the pins are less than 4 volts, contact DynaNav Systems Inc. for computer 

replacement. 
To test the switch inputs for the above 

• Remove 9 pin CPC plug (coming from aircraft switches) from Dual Relay box. 
• Connect ohmmeter (20 ohm range) common to pin 9 of plug coming from Aircraft wiring 
• Test 0 ohms on pin 8 when enter switch is activated 
• If this does not happen, troubleshoot the aircraft wiring from plug to Window switch 

Up, Down, Left, or Right switch does not work some or all of the time. 
To test Air Computer for above 

• Remove 9 pin CPC plug (coming from processor box) from Dual Relay box. 
• Power up DynaFlight system 
• Connect voltmeter (20 volt range) common to pin 9 of plug coming from Aircraft wiring 
• Test for power on pins 1 through 8, should be between 4.5 and 5 volts DC 
• If any of the pins are less than 4 volts, contact DynaNav Systems Inc. for computer 

replacement. 
To test the switch inputs for the above 

• Remove 9 pin CPC plug (coming from aircraft switches) from Dual Relay box. 
• Connect ohmmeter (20 ohm range) common to pin 9 of plug coming from Aircraft wiring 
• Test 0 ohms on pins 1 through 4 when tophat Left, Right, Up or Down switch is activated. 
• If this does not happen, troubleshoot the aircraft wiring from plug to Enter switch 

Deploy or Retrieve functions do not work. 
To test Air Computer for above 

• Remove 9 pin CPC plug (coming from processor box) from Dual Relay box. 
• Power up DynaFlight system 
• Connect voltmeter (20 volt range) common to pin 9 of plug coming from Aircraft wiring 
• Test for power on pins 1 through 8, should be between 4.5 and 5 volts DC 
• If any of the pins are less than 4 volts, contact DynaNav Systems Inc. for computer 

replacement. 
To test the switch inputs for the above 

• Remove 4 pin CPC plug (coming from aircraft Deploy/Retrieve switches) from Dual Relay box. 
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• For Deploy, connect voltmeter (200 volt range) between pins 1 & 4 of the 4 pin plug coming 
from Aircraft wiring and test for 24 volts when the aircraft Deploy switch is activated (aircraft 
power must be on). 

• For Retrieve, connect voltmeter (200 volt range) between pins 2 & 3 of the 4 pin plug coming 
from Aircraft wiring and test for 24 volts when the aircraft Deploy switch is activated (aircraft 
power must be on). 

• If the above voltage is not there, troubleshoot the aircraft wiring from plug to the Deploy and 
Retrieve switches or Relays 

• NOTE: some aircraft are wired for Retrieve switch connected between pins 9 and 6 of the 9 pin 
CPC plug coming from the aircraft wiring. This would wired for continuity when switch is 
activated. 

• If the above conditions check OK, then the fault will be in the DB2-1224-4 Dual Relay box. 
Contact DynaNav Systems Inc. for replacement. 

Flight Plans are not being received from the Ground software. 
Telemetry System not working properly 

Telemetry Air Module 
Antenna or Antenna Cable problem 

• Check continuity of coax Cable to antenna connector. Make sure that the center pin is not 
grounded to the aircraft ground. 

Telemetry Switch settings are set correctly 
• Make sure that the switch settings are as per “Telemetry Settings Table” in chart below for both 

the Ground Telemetry Module and the Aircraft Telemetry Module. 
• The switches should set on Config 1 on both should be the same as per chart 
• The switches should set on Config 2 on both should be the same as per chart or whatever setting 

you would like 
• The switches should set on Config 3 on both should be as per chart. NOTE: The switch 4 will 

be ON for the Ground Module and OFF for the Air Module. 
• The switches should set on Config 4 on both should be the same as per chart – all OFF. 

Aircraft not properly registered on the Ground Software. 
•  

Aircraft System Software 
Aircraft Operating System Card problem 
System shows display and freezes during boot 

• Contact DynaNav Systems Inc.  
During boot the display shows “ This system is using unlicensed version of 
software” then shuts down. 

• Contact DynaNav Systems Inc.  
Aircraft Air Card problem 
System Shuts down on boot 

If a new Air Card is being used and will not work in aircraft system: 
• Incomplete or no install of Air Card program. 
• Format has been done on card 
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NOTE:- DO NOT FORMAT COMPACT FLASH CARDS. Specifically, do not format in 
WINDOWS XP or in FAT32, it will permanently destroy the card for proper formatting again for 
operation of the system. 

If original Air Card is being used and will not work in aircraft system: 
Air Card has corrupted files 

• Do Error Checking on card – In Windows Explorer – right click on the drive letter of the Air 
Card (e.g. E:) and click on “Properties”, then click on the “Tools” tab, then do “Error Checking” 
then “Check Now”. Check the box for “Automatically fix file system errors” and proceed. 

• If there are no errors, put in Spare card and transfer data from the computer to the new Air Card.  
• When the new Spare card is working, remove all the files off of the bad Air Card and re-install 

the software “BagAir Telemetry Full Install…..” that should be on the Key Card of the Base 
computer. 

•  Contact DynaNav Systems Inc. for further instructions. 
System Has an Error and Freezes 

• Replace Air Card with new one and contact DynaNav Systems Inc. for further instructions. 
System has an Error and Shuts down. 

• Replace Air Card with new one and contact DynaNav Systems Inc. for further instructions. 
Certain Functions do not work on the Air System. 

Error in database 
See File corruption 

File Corruption 
Reasons 

• Powering down the DynaFlight system while it is still saving information. ALWAYS USE 
“QUIT” BUTTON. 

• Removing the card from the DynaFlight while the system is still operational.  
• Airport x-ray machines (recommended to be carried on your person). 
• Sitting the cards on or near strong magnetic sources. 
• Removing the card from the Ground Computer reader while you have files that are on the card 

open. 
•  File corruption is caused by many things and our memory cards are less susceptible than 

regular hard drives or other media with moving parts. 
Solution 

• Run Scandisk against the card by going to Windows Explorer and right click on the Drive Letter 
of the Air Card and select “Properties”. Now select “Tools” menu and do “Error Checking” and 
click on “Check Now”. Be sure to select “Automatically fix Errors” check box. If it shows 
errors after this check, then that will be the problem. 

• If the above does not work then re-install the Air Card program onto the card. 
• If that does not work use a new Air Card. If it is a new Card, make sure you run in the 

helicopter first before transferring data onto the card. 
Ground System Hardware 
No Telemetry communication to Aircraft 
PC Computer 

No Green TX light flashing on the Telemetry box inside the Telemetry Ground module. 
Probable Causes 

• Com Port being used is not selected on the SeisBag Ground software 
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• Com Port has failed on the computer. 
Telemetry Ground Module 

No Red light on the Telemetry box inside the grey Telemetry Ground module. 
Probable Causes 

• 12 Volt DC power supply is not plugged in, dead or broken wires on the cable.  
• Check wiring as per Telemetry Ground Cable Wiring chart below 

Antenna or Antenna Cable problem 
• Check continuity of coax Cable to antenna connector. 

Telemetry Switch settings are set correctly 
• Make sure that the switch settings are as per “Telemetry Settings Table” in chart below for both 

the Ground Telemetry Module and the Aircraft Telemetry Module. 
• The switches should set on Config 1 on both should be the same as per chart 
• The switches should set on Config 2 on both should be the same as per chart or whatever setting 

you would like 
• The switches should set on Config 3 on both should be as per chart. NOTE: The switch 4 will 

be ON for the Ground Module and OFF for the Air Module. 
• The switches should set on Config 4 on both should be the same as per chart – all OFF. 

Telemetry Air Module (See “Flight Plans are not being received from the Ground 
software” above) 
Aircraft not properly registered on the Ground Software. 

• On the Ground software, when Area being worked on is selected, under the “Aircraft” pull 
down menu, select “Remove one from Area”. 

• Next, select and highlight the aircraft name that is giving a problem and then hit “OK” 
• After this, put the Air Card in the PC slot and go to the “Transfer” window and select the Area 

on the Air Card and transfer back to the Ground. This will re-register Aircraft for this area. 
Ground System Software 
Stations and/or bags that were there before no longer appear 
Check that the buttons on the right hand side of the map are ‘down’ for the bags 
or stations (red square for stations, green square for bags). 
More than one area name that is being used at the same time.   

• Check the available area names and look at each. 
Verify the latitude and longitude on the map corresponds to the location of the 
work  

• Select the top button on the left (the ‘X’), and make sure that both the bag and station buttons 
are ‘down’ on the right. 

• Possibly a station has been entered that is not near the job.  If this is true, when you move the 
mouse around you should see a distance to this point.  Move the map until you are over the 
point, then use the delete tool to delete this station.  When you reselect the area it should now 
center on the part with the ‘real’ stations on it. 

Select the ‘Lists’ button and verify the actual stations and line numbers. 
Points don’t appear in the ‘List’ view 

• Re-import them from the seg file.   
• The ‘bag’ locations, if any exist on a card, can be brought back in from the card by using the 

‘Transfer’ window, and transferring bag locations from the PC Card Drive back into the 
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computer.  Any bag locations that are not on the card or the computer must then be added as 
usual. 

Indexes to the tables are corrupt: 
• Under the ‘File’ menu, select ‘Re-index Tables’ 

Importing SEG’s 
SEG File doesn’t import properly 

Seg File Line Lengths: 
• The most likely problem is that the file being imported is not of fixed line length.  Each line of 

data (not the header information lines) must be of exactly the same length.  This is a ‘standard’ 
for SEG files.   

• View the file in a text editor like ‘word pad’ and verify that each line is the same length.  If not, 
ask the survey crew to produce another file.  If they can’t, then there is another method that may 
work:  you may attempt to import the automatically generated file ‘c:\temp\badlines.txt’.  This 
file contains only the lines that didn’t import from the original SEG file.  Repeat doing an 
import using this file may get all the stations in.   

Regional Settings on your computer.  
• Some ‘locales’ (many in the world) use a comma where we use a period, and vice versa.  This 

causes problems when trying to import.  The solution is to change your computer to a North 
American compatible locale. 

SEG file formatting incorrect 
• The SEG file must be in a text format with no periods, commas, etc. This file is a space 

delimited file of a fixed line length. 
Seg File imports, but points don’t show up on the map 
Make sure that the buttons on the right are down for bags and stations (the little red 
square and the little green square) 
Select the ‘Lists’ button, and then check that the stations are there in the lists of stations 
for each line imported.  If not: 

• Check that you have selected the correct area name 
• Under the ‘File’ menu, select ‘Re-Index Tables’. 
• If the still don’t show up, look in the ‘c:\temp’ directory for a file named ‘badlines.txt’.  If this 

file contains all the points you were trying to import, then there is a problem with the file.  See 
the section above on this. 

Map is on the wrong Latitude/Longitude 
• Select the top button on the left side of the map.  Select the ‘stations’ button on the right (this is 

the button with the little red square in it).   
• Click on the map, and check the latitude/longitude reported, and the distance to the nearest 

station (shown in meters in the lower-right of the screen).  If this point is nearby, try and center 
this point (zoom out if necessary).  Click in a direction that reduces the distance to the point.  
When it is in view and it is not supposed to be there (at that latititude and longitude) then this 
point was probably imported in error somehow.   

• Find its station ID in the upper right corner.  Switch to the ‘Lists’ view, and delete this 
station(s).    When all these bad stations are deleted, you should be able to re-select the area and 
it will center on the real data.  Get the surveyors to produce you a new SEG file with 
replacements for the bad stations and import these.  
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Stations show up on the map, but are not where they should be: 
Pilot reports that the bags are showing thousands of miles away 

• Stations were imported from the SEG file with the wrong longitude sign (East instead of West) 
The stations are consistently offset by up to 300 meters from where they should 
be when the pilot flies the lines. 

• In all probability the stations were imported using the wrong datum.  This system accepts 
WGS84 (NAD83) data only.  Check with your surveyors. 

• Perhaps the bags have been placed on the stations with the wrong offsets.  The pilot only sees 
bag locations, and not the stations. 

The spacing of the lines / stations are erratic. 
The data was imported assuming that the format was, say, (degrees, minutes, 
seconds, decimal seconds) but the SEG file was produced using (degrees, minutes, 
decimal minutes).   

Traditionally the SEG file has a line just above the data itself telling you the format of the 
data.  Make sure that you select the matching format in the SEG importer. 

• To view the SEG file to see the format, you may start with Notepad (under your accessories 
menu).  You will have to select File: Open, then change the file type to ‘All Files’, then find the 
seg file.  When you go to open this file it will probably say it is too large, then it will ask you if 
you want to open it in WordPad.  Say ‘yes’ to this and it will open. 

If necessary, ask your surveyor to make you a new file in a format you are familiar with. 
• If you re-import a new file, you can ask to overwrite the stations that are in there with the new 

ones.  Generally it is safe to overwrite stations. 
•   This will NOT change any bag locations you have established.  These will have to be changed 

separately. Remove all existing Bag locations and create new Bag locations and then transfer to 
Air Card. 

The survey data is wrong (far less likely, but not impossible). 
• Survey Data can be checked by creating a Bag location over an imported reference point and fly 

to this exact location. The pilot navigation point should match exactly over that location. 
Transferring Files to Aircraft Card 
Make sure the Drive letter for the Air Card is selected to transfer. 

The Air Card does not show up as ready to Transfer 
• The Air Card has not been run in the helicopter after new program installed. Must be done 

before transfer can happen. 
• The Air Card is corrupt – follow “Aircraft Air Card problem” above. 

Telemetry System 
 Aircraft System is not receiving Flight Plans through Telemetry 

Aircraft not properly registered on the Ground Software. 
• On the Ground software, when Area being worked on is selected, under the “Aircraft” pull 

down menu, select “Remove one from Area”. 
• Next, select and highlight the aircraft name that is giving a problem and then hit “OK” 
• After this, put the Air Card in the PC slot and go to the “Transfer” window and select the Area 

on the Air Card and transfer back to the Ground. This will re-register Aircraft for this area. 
Aircraft is not being tracked on the moving map (see “Ground System Hardware” 
– “No Telemetry communication to Aircraft” above. 
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Control and Power Wiring Diagram 
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Telemetry Settings Table 
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